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EasyConnect RCT 1.0

■ HFA II-i Remote Configuration Tool
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Copyright

© 2007 Carl Zeiss Meditec, Inc. All rights reserved. 

Trademarks

EasyConnect, Humphrey, HFA-NET, and HFA-NET Pro are either registered trademarks or trademarks

of Carl Zeiss Meditec, Inc. in the United States and/or other countries. 

Windows is a registered trademark of Microsoft Corporation in the United States and/or other

countries.

Bonjour, the Bonjour logo, and the Bonjour symbol are trademarks of Apple Computer, Inc.

All other trademarks used in this document are the property of their respective owners.
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EasyConnect RCT 1.0

IMPORTANT: It is strongly recommended that you use the EasyConnect™ RCT in Easy

Mode instead of manually configuring your network settings on your HFA II-i

instruments.

Overview

EasyConnect RCT 1.0 (RCT) is a remote configuration program that configures network settings for

HFA-NET™ on Humphrey® HFA II-i instruments running system software version 4.2 or later. The

RCT uses a multi-page wizard to guide the operator step-by-step through the HFA-NET configuration

process. It provides a simple mode of operation that will make most of the decisions, selecting

default values for configuration data. 

The RCT runs from a computer connected to an existing network—not from an HFA II-i instrument.

The RCT runs on NT 5.x based Windows® systems: 

• Windows 2000

• Windows 2003 Server

• Windows XP

Configurable features are HFA-NET and HFA-NET Pro™ Windows file sharing Shared folder and

Shared Printer setups. FTP (File Transfer Protocol) connections must still be configured manually.

• Before You Run the RCT, page 2

• Enable the RCT and Name HFA II-i Instruments, page 4

• Launch the RCT, page 4

• Easy Mode (default), page 6

• Copy Mode, page 14

• Custom Mode, page 20

• Report Mode, page 31

• Test Mode, page 36

• Troubleshooting, page 44
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Before You Run the RCT

Connect HFA II-i to Your Network

Use an Ethernet cable to connect your HFA II-i to your existing network (see “Connecting Your

Network Components” on page H-3 in the HFA II-i series User Manual).

Firewall Software

Firewall software is designed to limit the transfer of data from one computer to another (e.g., from

the HFA to the computer/server), so it will interfere with HFA networking functionality. If you are

running firewall software on your system, you will need to change its settings as described below.

Windows XP Firewall: If you are using Windows XP Firewall (the default on most Windows XP

systems), then you will need to open Ports 137, 138, 139 and 445 to allow the HFA to transfer files

to your computer. The Open Ports button on the WELCOME screen opens these ports (see Welcome

Screen on page 4). When selected, a Question dialog will be displayed. Select Yes to continue. No

further action on your part will be required. If some or all of the ports are already opened, the Open

Ports button will keep them opened.

Other Firewall: If you are using any other firewall software, you will still need to open Ports 137, 138,

139 and 445. Please see your firewall documentation for instructions.

For more details, see Troubleshooting on page 44.

Windows File Sharing Settings

Some networks require an additional modification to allow file sharing. If the RCT runs successfully,

but Test Connection returns “failed”, you may need to modify your Windows File Sharing setting:

The Use simple file sharing (Recommended) check box in Windows XP must NOT be selected. To

access this setting, go to My Computer > Tools > Folder Options… and select the View tab. Scroll

to the bottom of the Advanced settings section and ensure that Use simple file sharing

(Recommended) is NOT selected. For more details, see Troubleshooting on page 44.

Licensing

The networking features (i.e., HFA-NET, HFA-NET Pro) configured by the RCT are only available as

licensed software. Make sure you have activated them on your HFA II-i before running the RCT.
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Enable the RCT and Name HFA II-i Instruments

Each HFA II-i instrument must have “Allow Remote Configuration” selected to allow the RCT to

configure the instrument. This setting is selected by default. In addition, it is strongly recommended

to name your HFA II-i instruments for ease in identification when using the RCT. Creating a name for

an instrument can also allow you to know the location of the instrument.

To name your HFA II-i instruments and allow them to be configured with the RCT, follow the steps

below:

1 On the HFA II-i instrument, from the Main Menu, select SYSTEM SETUP > COMMUNICATIONS

SETUP > HFA NETWORK SETUP to display the HFA NETWORK SETUP SCREEN (Figure 1). 

Figure 1: HFA Network Setup Screen

2 Select ALLOW REMOTE CONFIGURATION so that an X is displayed in the button. This allows the

RCT to configure the HFA II-i instrument.

3 Select HFA NAME to display a pop-up keyboard and enter (or change) the name (up to 24

characters) you want for this HFA II-i instrument. Press ENTER.

4 Select SAVE to save your changes.
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Launch the RCT

☞ Note: The RCT application does not need to be installed on your computer—it is launched directly

from its CD. You must launch the RCT application on the computer that your shared folder and files

will reside on. This is your “HFA-Net File Server.”

To launch the RCT application, follow these steps:

1 Put the EasyConnect RCT 1.0 CD in your computer’s (HFA-NET File Server) optical drive. 

2 After several seconds, the program should start automatically. If not, click Start > Run, type

E:\RCT.exe (where E is the optical drive), and click OK.

Welcome Screen

The RCT opens to the WELCOME screen (Figure 2) with the English language and Easy mode selected

by default. The RCT provides five modes of operation: Easy (default mode), Copy, Custom, Report,

and Test. These modes are described in detail in the following sections. The RCT can be run in five

languages by selecting the language from the SELECT A LANGUAGE radio buttons. Once selected, the

RCT will automatically restart in the selected language.

☞ Note: The user must be logged in as an Administrator of the computer running the RCT to use all

modes except Report.

Figure 2: EasyConnect RCT– Welcome Screen

Select the Open Ports button to open all ports in Windows XP firewall required for file sharing. See

Firewall Software on page 2 for more information.

Select the User Guide button to view the EasyConnect RCT 1.0 User Guide on screen in Adobe

Reader. The User Guide can also be opened by right-clicking on any screen in RCT and selecting

User Guide. If you do not have Adobe Reader installed, go to www.adobe.com to download and

install the free Adobe Reader.

http://www.adobe.com
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When the Next button is selected for the first time, a LICENSE AGREEMENT window is opened (Figure

3). Read the license agreement and then select the Agree button to continue using the RCT.

Figure 3: License Agreement Window
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Easy Mode (default) 

Easy mode configures a set of instruments by setting up all their shared folders or shared printers in

a few steps. Standard defaults are provided for all entered configuration data. The default RCT User

Name is “Zeiss” and the default RCT Password is “November171846”. All licensed features will be

configured.

☞ Note: It is strongly recommended that you use Easy mode to configure your HFA if it is not already

using networking features.

☞ Note: If you have a previously created User Account with the User Name “Zeiss” and a password

different than the default RCT Password “November171846”, you will need to use Custom mode

and enter the correct password for the “Zeiss” User Account. If this may be the case, a dialog will be

displayed alerting you and allowing you to continue or enter Custom mode.

The following steps describe how to configure your instruments using Easy mode.

1 Select EASY from the SELECT A CONFIGURATION MODE radio buttons (Figure 4) and then select

NEXT to continue.

Figure 4: Select Easy Configuration Mode
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The RCT displays a message alerting you there will be a delay before proceeding (Figure 5).

Figure 5: Please Wait Message

☞ Note: If all your HFA instruments cannot respond fast enough you will receive a message such as

“No instruments are responding. Please try again later” or “Could not retrieve instrument
configuration data. Please try again later.” If at least one HFA instrument responds, you will not

receive a message. If you receive one of these messages, select the Back button until you see the

EasyConnect RCT Welcome screen, and then run the RCT again.
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2 Select either the SHARED FOLDER or SHARED PRINTER button (Figure 6) and then select NEXT to

continue. Shared Folder sets up Data Export, EMR/PMS, Archive/Retrieve, and network backup.

Shared Printer configures the HFA to use a shared printer connected to the computer.

Figure 6: Select Shared Folder

3 A list of all networked HFA II-i instruments will be displayed (Figure 7). All instruments are

selected by default. Select the instruments you want to configure and then select NEXT to

continue. CTRL-CLICK to select or deselect multiple instruments.

Figure 7: Select Networked HFA Instruments to Configure
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The RCT displays a message alerting you there will be a delay before proceeding (Figure 8).

Figure 8: Please Wait Message

☞ Note: You must select at least one instrument to continue.

☞ Note: The name of the HFA II-i instrument can be created on the instrument in the HFA Network

Setup Screen. Creating a name for an instrument can allow you to know the location of the

instrument. If you do not create a name, then the Name field in the instrument list will be empty

(see Enable the RCT and Name HFA II-i Instruments on page 3). 
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4 If you previously selected a shared folder type of HFA setup, enter the name of the shared folder

or select the BROWSE button to locate and specify the shared folder. Select Create separate

subfolders for Work List and EMR/PMS Export if you want to have separate subfolders inside the

shared folder for those features (Figure 9). This may be required by some EMR products.

Figure 9: Enter or Browse for Folder

A default share name for the folder will be created with the name “C:\CZM\HFA2i” if that name

is not already used. If you enter a folder name that does not currently exist, you will be asked if

you want to create it. If you enter or select a folder that is not currently shared, then the RCT

will make it sharable. 

☞ Note: The RCT only allows you to create a shared folder on a local drive.

The RCT will obtain the computer's name and IP address to set up the selected instruments.

If they do not already exist, the RCT will also create subfolders for each configurable feature

(Separate Worklist and EMR/PMS Export subfolders will only be created if you have that option

selected). The instruments will be configured to use these subfolders for the corresponding fea-

ture setup.

Select NEXT to continue.

Table 1-1 Subfolders for Configured Features

Feature Setup Subfolder Name 

Archive/Retrieve Setup Archive

Data Export Setup Data_Export

EMR/PMS Export Setup EMR_Export (optional)

Worklist Setup Work_List (optional)
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5 If you previously selected a shared printer type of HFA setup, select a printer you want to share

from the list of printers connected to the computer (Figure 10). The first printer is selected by

default.

☞ Note: You must designate the correct printer for the selected printer on the HFA II-i to print

successfully (Main Menu > System Setup > Printer > Shared to select the shared printer). You need

to also select the correct printer type as PCL-5, LASERJET COMPATIPLE, or PCL-3, DESKJET

COMPATIPLE  (Main Menu > System Setup > Print Setup > Custom Print Setup > Print Type).

Figure 10: Select a Printer to Share

If you select a printer that is not currently shared, then the RCT will make it sharable. 

A default share name for the printer will be created with the name “CZM-HFA2i-Printer” if that

name is not already used. The RCT will obtain the computer's name and IP address to set up

the selected instruments.

Select NEXT to continue.
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6 The RCT will display a Commit screen (Figure 11) before sending configuration messages to any

instrument. This screen gives you a last chance to make corrections before committing the

specified changes. Select BACK to go back to the previous screen(s) to make any corrections.

Selecting CANCEL will exit the RCT without configuring any of the selected instruments.

Figure 11: Commit Screen

Select the PERFORM CONNECTION TESTS checkbox to perform a connection test for each config-

ured setup. Results of these tests will be presented on the Completion screen and a VIEW TEST

LOG button will be provided if any instrument failed a connection test.

☞ Note: In some networks, the RCT will run successfully and configure the HFA, but the connection

test will still fail, indicating that the HFA cannot currently export files to the shared folder. If a

connection test fails, see Troubleshooting on page 44 for more information.

When you select NEXT, all selected instruments will be sent the specified configuration. 
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The RCT displays a message alerting you there will be a delay before proceeding (Figure 12).

Figure 12: Please Wait Message

7 If the PERFORM CONNECTION TESTS button was not selected (default), then after selecting NEXT

on the Commit screen, a final Completion screen will be displayed (Figure 13). If you selected

PERFORM CONNECTION TESTS, then each selected instrument will be tested before a final

Completion screen will be displayed (See Steps 3–5 in the Test mode section, page 39–43).

Each connection test could take several minutes. Select FINISH to exit the RCT. 

Figure 13: Completion Screen (No connection tests)
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Copy Mode

Copy mode copies the configuration of one instrument to one or more other instruments. Copy

mode behaves as if you had used Easy mode and manually entered the configuration of the source

instrument, rather than having the configuration automatically created.

The following steps describe how to use Copy mode.

1 Select COPY from the SELECT A CONFIGURATION MODE radio buttons (Figure 14) and then select

NEXT to continue.

Figure 14: Select Copy Configuration Mode
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The RCT displays a message alerting you there will be a delay before proceeding (Figure 15).

Figure 15: Please Wait Message

☞ Note: If all your HFA instruments cannot respond fast enough you will receive a message such as

“No instruments are responding. Please try again later” or “Could not retrieve instrument
configuration data. Please try again later.” If at least one HFA instrument responds, you will not

receive a message. If you receive one of these messages, select the Back button until you see the

EasyConnect RCT Welcome screen, and then run the RCT again.
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2 A list of all networked HFA II-i instruments will be displayed (Figure 16). The first instrument is

selected by default. Select the source instrument you want to copy from by clicking on it and

then select NEXT to continue.

Figure 16: Select the Source Networked HFA Instrument to Copy

☞ Note: The name of the HFA II-i instrument can be created on the instrument in the HFA Network

Setup Screen. Creating a name for an instrument can allow you to know the location of the

instrument. If you do not create a name, then the Name field in the instrument list will be empty

(see Enable the RCT and Name HFA II-i Instruments on page 3). 
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The RCT displays a message alerting you there will be a delay before proceeding (Figure 17).

Figure 17: Please Wait Message

3 A list of all other (non-source) networked HFA II-i instruments will be displayed (Figure 18). All

instruments are selected by default. Select one or more destination instruments you want to

copy the source configuration to and then select NEXT to continue. CTRL-CLICK to select or

deselect multiple instruments.

Figure 18: Select the Destination Networked HFA Instruments
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4 The RCT will display a Commit screen (Figure 19) before sending configuration messages to any

instrument. This screen gives you a last chance to make corrections before committing the

specified changes. Select BACK to go back to the previous screen(s) to make any corrections.

Selecting CANCEL will exit the RCT without configuring any of the selected instruments. 

Figure 19: Commit Screen

Select the PERFORM CONNECTION TESTS checkbox to perform a connection test for each config-

ured setup. Results of these tests will be presented on the Completion screen and a VIEW TEST

LOG button will be provided if any instrument failed a connection test.

☞ Note: When Copy Mode is committed only features that are licensed on both the source and

destination instrument will be configured.

When you select NEXT, all selected instruments will be sent the specified configuration. 
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The RCT displays a message alerting you there will be a delay before proceeding (Figure 20).

Figure 20: Please Wait Message

5 If the PERFORM CONNECTION TESTS button was not selected (default), then after selecting NEXT

on the Commit screen, a final Completion screen will be displayed (Figure 21). If you selected

PERFORM CONNECTION TESTS, then each selected instrument will be tested before a final

Completion screen will be displayed (See Steps 3–5 in the Test mode section, page 39–43).

Each connection test could take several minutes. Select FINISH to exit the RCT. 

Figure 21: Completion Screen (No connection tests)
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Custom Mode

Custom mode configures one or more instruments by specifying the setup for a specified set of

features. 

☞ Note: The difference between Easy and Custom modes is that in Custom mode the specified setup

will be applied to the selected features of the selected instruments, while in Easy mode the setup

will be applied to all features of the selected instruments.

☞ CAUTION: If you use Custom mode and change the User Name and/or password, you will not be

able to use Easy mode. Use Copy mode to copy the Custom mode configuration to other

instruments.

The following steps describe how to use Custom mode.

1 Select CUSTOM from the SELECT A CONFIGURATION MODE radio buttons (Figure 22) and then

select NEXT to continue.

Figure 22: Select Custom Configuration Mode
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The RCT displays a message alerting you there will be a delay before proceeding (Figure 23).

Figure 23: Please Wait Message

☞ Note: If all your HFA instruments cannot respond fast enough you will receive a message such as

“No instruments are responding. Please try again later” or “Could not retrieve instrument
configuration data. Please try again later.” If at least one HFA instrument responds, you will not

receive a message. If you receive one of these messages, select the Back button until you see the

EasyConnect RCT Welcome screen, and then run the RCT again.
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2 The RCT will prompt for a Custom mode password before beginning the Custom configuration

process (Figure 24). Enter “November171846” for the password and then select NEXT to

continue. This login is included to provide a security barrier to the more advanced Custom

configuration mode.

Figure 24: Enter Custom Mode Password

3 Select either the SHARED FOLDER or SHARED PRINTER button (Figure 25) and then select NEXT to

continue.

Figure 25: Select Shared Folder
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4 A list of all networked HFA II-i instruments will be displayed (Figure 26). All instruments are

selected by default. Select the instruments you want to configure and then select NEXT to

continue. CTRL-CLICK to select or deselect multiple instruments.

Figure 26: Select Networked HFA Instruments to Configure

☞ Note: The name of the HFA II-i instrument can be created on the instrument in the HFA Network

Setup Screen. Creating a name for an instrument can allow you to know the location of the

instrument. If you do not create a name, then the Name field in the instrument list will be empty

(see Enable the RCT and Name HFA II-i Instruments on page 3). 
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The RCT displays a message alerting you there will be a delay before proceeding (Figure 27).

Figure 27: Please Wait Message

5 The RCT will display a list of configurable features for the first selected instrument (Figure 28

and Figure 29). This list is restricted to those of the previously selected setup type—shared

folder or shared printer. 

Currently available shared folder HFA II-i features include:

• Archive/Retrieve Setup – Archiving data to a file server and retrieving archived data from a

file server. Synchronizing data on two or more HFA II-i instruments.

• EMR/PMS Export Setup (HFA-NET Pro only) – export information to an Electronic Medical

Records (EMR) system or Patient Management System (PMS).

• Data Export Setup – Exporting patient data, PDF and TIFF image files from a HFA II-i.

• Work List Setup (HFA-NET Pro only) – import work lists from your practice’s EMR/PMS system.

Currently, the only available shared printer HFA II-i feature is Shared Printer Setup.

Network configuration of these features can be set and viewed manually on the COMMUNICA-

TION SETUP Screen of the selected HFA II-i instrument.

☞ Note: Only licensed features will be shown in the list for the selected instrument.

Select one or more features you want to configure and then select NEXT to continue. CTRL-CLICK

to select or deselect multiple features.
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Figure 28: List of Configurable Features (Shared Folder)

Figure 29: List of Configurable Features (Shared Printer)

The File Server is the name of the computer. Share is the path of the shared folder or printer,

and User Name is the Windows user name.
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6 If you previously selected a shared folder type of HFA setup, enter the path of the shared folder

or select the BROWSE button to locate and specify the shared folder. Select Create separate

subfolders for Work List and EMR/PMS Export if you want to have separate subfolders inside

the shared folder for those features (Figure 30). This may be required by some EMR products.

Figure 30: Enter or Browse for the Folder to Share

A default share name for the folder will be created with the name “C:\CZM\HFA2i” if that name

is not already used. If you enter a folder that does not currently exist, you will be asked if you

want to create it. If you enter or select a folder that is not currently shared, then the RCT will

make it sharable.

☞ Note: The RCT only allows you to create a shared folder on a local drive.

The RCT will obtain the computer's name and IP address to set up the selected instruments.

If they do not already exist, the RCT will also create subfolders for each configurable feature

(Separate Worklist and EMR/PMS Export subfolders will only be created if you have that option

selected). The instruments will be configured to use these subfolders for the corresponding fea-

ture setup.

Select NEXT to continue. 

Table 1-2 Subfolders for Configured Features

Feature Setup Subfolder Name 

Archive/Retrieve Setup Archive

Data Export Setup Data_Export

EMR/PMS Export Setup EMR_Export (optional)

Worklist Setup Work_List (optional)
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7 If you previously selected a shared printer type of HFA setup, select a printer you want to share

from the list of printers connected to the computer (Figure 31). The first printer is selected by

default.

☞ Note: You must designate the correct printer for the selected printer on the HFA II-i to print

successfully (Main Menu > System Setup > Printer > Shared to select the shared printer). You need

to also select the correct printer type as PCL-5, LASERJET COMPATIPLE, or PCL-3, DESKJET

COMPATIPLE  (Main Menu > System Setup > Print Setup > Custom Print Setup > Print Type). 

Figure 31: Select a Printer to Share

If you select a printer that is not currently shared, then the RCT will make it sharable. 

A default share name for the printer will be created with the name “CZM-HFA2i-Printer” if that

name is not already used. The RCT will obtain the computer's name and IP address to set up

the selected instruments. 

Select NEXT to continue.
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8 The RCT will prompt for the User Name and Password of the shared folder (or printer) (Figure

32). The default RCT User Name is “Zeiss” and the default RCT Password is “November171846”.

Accept the default or enter another user name and password and then select NEXT to continue.

☞ Note: If you use a User Name in Custom mode from a previously created User Account, and enter a

password that is not the same as from the previous account, a dialog will be displayed alerting you

and allowing you to continue or change the User Name and/or password.

Figure 32: Enter User Name and Password for the Share

9 The RCT will repeat prompting for a selection from each instrument's features until all selected

instruments have been configured.
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10After all instruments have been configured, the RCT will display a Commit screen (Figure 33)

before sending configuration messages to any instrument. This screen gives you a last chance

to make corrections before committing the specified changes. Select BACK to go back to the

previous screen(s) to make any corrections. Selecting CANCEL will exit the RCT without

configuring any of the selected instruments.

Figure 33: Commit Screen 

Select the PERFORM CONNECTION TESTS checkbox to perform a connection test for each config-

ured setup. Results of these tests will be presented on the Completion screen and a VIEW TEST

LOG button will be provided if any instrument failed a connection test.

When you select NEXT, all selected instruments will be sent the specified configuration. 
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The RCT displays a message alerting you there will be a delay before proceeding (Figure 34).

Figure 34: Please Wait Message

11If the PERFORM CONNECTION TESTS button was not selected (default), then after selecting NEXT

on the Commit screen, a final Completion screen will be displayed (Figure 35). If you selected

PERFORM CONNECTION TESTS, then each selected instrument will be tested before a final

Completion screen will be displayed (See Steps 3–5 in the Test mode section, page 39–43).

Each connection test could take several minutes. Select FINISH to exit the RCT.

Figure 35: Completion Screen (No connection tests)
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Report Mode

Report mode displays the configuration of a selected set of instruments. Any user can run Report

mode—the user does not need to be an Administrator.

The following steps describe how to use Report mode.

1 Select REPORT from the SELECT A CONFIGURATION MODE radio buttons (Figure 36) and then

select NEXT to continue.

Figure 36: Select Report Configuration Mode
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The RCT displays a message alerting you there will be a delay before proceeding (Figure 37).

Figure 37: Please Wait Message

☞ Note: If all your HFA instruments cannot respond fast enough you will receive a message such as

“No instruments are responding. Please try again later” or “Could not retrieve instrument
configuration data. Please try again later.” If at least one HFA instrument responds, you will not

receive a message. If you receive one of these messages, select the Back button until you see the

EasyConnect RCT Welcome screen, and then run the RCT again.
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2 A list of all networked HFA II-i instruments will be displayed (Figure 38). All instruments are

selected by default. Select the instruments you want to display configurations for and then

select NEXT to continue. CTRL-CLICK to select or deselect multiple instruments. 

Figure 38: Select Networked HFA Instruments to Display Configurations

☞ Note: The name of the HFA II-i instrument can be created on the instrument in the HFA Network

Setup Screen. Creating a name for an instrument can allow you to know the location of the

instrument. If you do not create a name, then the Name field in the instrument list will be empty

(see Enable the RCT and Name HFA II-i Instruments on page 1-3).
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The RCT displays a message alerting you there will be a delay before proceeding (Figure 39).

Figure 39: Please Wait Message

3 The RCT will display the network settings for each selected instrument, one instrument at a

time (Figure 40). Select NEXT to continue to the next selected instrument. 

Figure 40: Network Settings for a Selected Instrument

☞ Note: Automatic Settings will be displayed if network settings were created automatically. Manual

Settings will be displayed if the network settings were created manually.
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4 After displaying network settings for the last selected instrument, the RCT will display the

feature configuration details for each selected instrument, one instrument at a time (Figure 41).

Select NEXT to continue to the next selected instrument. 

Figure 41: Feature Configuration Details for a Selected Instrument

5 After all instruments have displayed their feature configurations, the RCT will display a

Completion screen (Figure 42). Select FINISH to exit the RCT.

Figure 42: Completion Screen
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Test Mode

Test mode tests the configuration of selected instruments. Any user can run Test mode—the user

does not need to be an Administrator.

☞ Note: In some networks, the RCT will run successfully and configure the HFA, but the connection

test will still fail, indicating that the HFA cannot currently export files to the shared folder. If a

connection test fails, see Troubleshooting on page 44 for more information.

The following steps describe how to use Test mode.

1 Select TEST from the SELECT A CONFIGURATION MODE radio buttons (Figure 43) and then select

NEXT to continue.

Figure 43: Select Test Configuration Mode
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The RCT displays a message alerting you there will be a delay before proceeding (Figure 44).

Figure 44: Please Wait Message

☞ Note: If all your HFA instruments cannot respond fast enough you will receive a message such as

“No instruments are responding. Please try again later” or “Could not retrieve instrument
configuration data. Please try again later.” If at least one HFA instrument responds, you will not

receive a message. If you receive one of these messages, select the Back button until you see the

EasyConnect RCT Welcome screen, and then run the RCT again.
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2 A list of all networked HFA II-i instruments will be displayed (Figure 45). All instruments are

selected by default. Select the instruments you want to test and then select NEXT to continue.

CTRL-CLICK to select or deselect multiple instruments.

Figure 45: Select Networked HFA Instruments to Test Configurations

☞ Note: The name of the HFA II-i instrument can be created on the instrument in the HFA Network

Setup Screen. Creating a name for an instrument can allow you to know the location of the

instrument. If you do not create a name, then the Name field in the instrument list will be empty

(see Enable the RCT and Name HFA II-i Instruments on page 3).
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The RCT displays a message alerting you there will be a delay before proceeding (Figure 46).

Figure 46: Please Wait Message

3 A Ready to Test screen will be displayed (Figure 47 and Figure 48). Select NEXT to begin testing

your configured instruments, one at a time. Figure 49 shows a connection test in progress for

the first instrument configured. When an instrument has finished testing, the entry in the Test

column changes to either “PASSED” or “FAILED.” Keep selecting NEXT until all instruments have

completed testing.

Figure 47: Configuration Complete in Test Mode – Ready to Test 
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Figure 48: Configuration Complete in Easy, Copy, or Custom Mode – Ready to Test

Figure 49: Connection Test in Progress for First Instrument
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4 After connection tests have been completed for all configured instruments, select NEXT to

continue to a final Completion screen where the results of all tests will be displayed (Figure 50,

Figure 51, and Figure 52).

Figure 50: Completion Screen in Test Mode (Pass)

Figure 51: Completion Screen in Easy, Copy, or Custom Mode (Pass)
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Figure 52: Completion Screen (Fail)

☞ Note: In some networks, the RCT will run successfully and configure the HFA, but the connection

test will still fail, indicating that the HFA cannot currently export files to the shared folder. If a

connection test fails, see Troubleshooting on page 44 for more information.
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5 A VIEW TEST RESULTS button will be provided if any instrument failed a connection test. Clicking

this button will display a log (Figure 53) for the first failed instrument showing the same

messages that are displayed during an HFA II-i Test Connection invoked from its Network

Diagnostics menu. Clicking OK will display a test log for the next instrument that failed the

connection tests, if any. A SAVE TEST RESULTS button will also be provided. Clicking this button

will open a dialog where you can save the test results to a text file (Figure 54). The default file

name is “ConnectionTestResults.txt” in the current working directory. This file contains the

results for all tested instruments, passed or failed.

Figure 53: Test Results

Figure 54: Save Test Results

6 Select FINISH to exit the RCT.
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Troubleshooting

Here are some common problems encountered while using the RCT, followed by possible solutions. 

Not all HFAs on the local network are visible in the list of configurable instruments
• Select the BACK button and try again. Instruments may be slow to respond or the network may

be too busy.

• Ensure that the “Allow Remote Configuration” check box has been selected in your HFA II-i (see
“Enable the RCT and Name HFA II-i Instruments,” on page 3). 

• Check to ensure that HFA is physically connected to the network. Check for loose network cable
connections or other sources of network problems.

The RCT was not able to configure the selected HFA
• Network Reliability Problems: This situation may indicate reliability problems with your

network. Once an HFA is visible in the RCT selection window, it should be possible to configure
it. Check for loose network cable connections or other sources of network problems.

HFA has been transfering exams successfully but subsequently fails
• Run the RCT again to refresh your configuration.

The RCT configured HFA successfully, but Test Connection failed

☞ Note: Some situations (for example, see HFA-Net Pro Enabled below) will cause the Test Connection

to return a “failed” message even though the HFA is properly configured and is capable of

transferring files to the server. It is often worthwhile to attempt to export an image file from the HFA

to determine if the configuration has indeed succeeded before moving on to the additional

troubleshooting steps below.

• Windows File Sharing Setting: For the HFA to be able to transfer files to the shared folder, the
Use simple file sharing (Recommended) check box in Windows XP must NOT be selected. To
access this setting, go to My Computer > Tools > Folder Options… and select the View tab.
Scroll to the bottom of the Advanced settings section and ensure that Use simple file sharing
(Recommended) is NOT selected, as shown below (Figure 55).

Figure 55 Folder Options Screen – View Tab

Use simple file sharing

(Recommended) is NOT

selected.
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• Access Through a Router: If there is a network router between your HFA and the computer you
are attempting to connect to, you may not be able to use the RCT to configure your HFA-Net
settings.

• Windows Firewall: If your file server employs Windows Firewall you should verify that it accepts
access on the following NETBIOS ports: 137, 138, and 139; and that it also allows access via
port 445 for CIFS over IP. See Firewall Software on page 2 for additional information. These
exceptions are exposed via the File and Printer Sharing Service in the Windows XP
Firewall dialog Exceptions Tab. If your instrument and server are in different subnets
(example: 172. vs 10.), then you will need to change the scope to “Any”.

• Non-Windows Firewall: This version was only tested with Windows Firewall. While the
exceptions noted above may also work with a non-Windows firewall, you should consult its
documentation for information about allowing CIFS access from an IP device.

• Working with a VPN: If you are operating with a VPN on the server, you may need to disable its
Security Policy. This may not be necessary, so try to operate the RCT first.

• HFA-Net Pro Enabled: If you have licensed HFA-Net Pro, but are not currently connected to an
Electronic Medical Records (EMR) system, Test Connection will return a “failed” message
because it expects a response from your EMR software. If no other failures are present, then
HFA networking features should still work. 
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